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Broedel:Using Useful Utilities
ilt Broedel will be a new face at our June
meeting. He brings vast experience with
computer hardware and software to his
presentation on adware, spyware, virus
obliteration, and more. It will be an informal
extempore presentation, with questions welcomed
and encouraged.

M

Utilities that will be evaluated will include:
* AdAware
* AVG anti-virus
* Spybot
* Norton Utilities
* SpySweeper
* McAfee Utilities
Topics will include:
* Detection and removal tactics regarding computer
invaders and viruses
* W ays in which to avoid adware and spyware
* Alternate browsers such as Firefox and Opera
* Viral threats in email attachments and downloads
* General security precautions such as firewalls

A New Feature
on our website

— Links of Interest —
Go to:
mvpcug.com/index1.htm

* Spyware Warrior
* Bleeping Computer
Click on the links to find out
more about these subjects.

No Summer Meetings
There will be no meetings in July
or August, 2005. Watch for the
September issue of Explorer for
details of the Sept. 6 meeting.
Have a safe and happy summer.

Meeting Agenda
Milt has been involved with computers for 30 years. He has his
own business, Milt's PC Service, through which he services and
trains home PC owners, as well as some small businesses.
He teaches computer skills at BOCES (where Bob Schaffer met
him) and volunteers at the North Utica Senior Center. He has also
taught at Utica College.
He writes a monthly PC Tip article for the Mid-York Weekly and
Pennysaver.

5:30
6:00
6:30
7:00
7:15
8:15
8:30

. . . . . . . Meet and Greet
. . . . Business Meeting
. . . . . . Program, Part 1
. . . . . . . . . . . . . . . Break
. . . . . . Program, Part 2
. . . . Drawing for Prizes
. . . . . . . . . Adjournment

Whitesboro High School Cafeteria - June 7, 2005 - 6PM
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Smart Computing Special

The MVPCUG EXPLORER is published
monthly from September through June by the
Mohawk Valley Personal Computer User Group,
Inc., PO Box 586, Marcy NY 13403-0586.
Opinions expressed herein are the writers and
are not reflective of the MVPCUG, nor are they
considered substantiated by inclusion in this
newsletter. All articles are copyrighted by their
respective authors but may be reprinted by other
User Groups provided credit is given to the author
and this publication.
The Mohawk Valley PC User Group, Inc.
(MVPCUG) was founded in 1981 by individuals
interested in IBM compatible computers. This nonprofit organization consists of volunteers whose
expertise range from novice to professional.
Regular meetings are held on the first Tuesday
of the month at 6pm, usually at the Whitesboro
High School, Route 291, Marcy NY. A typical
agenda consists of discussion of business affairs
and a demonstration of computer related products.
Meetings are open to the public.
Initial membership fee for an individual is $25.
Annual renewal dues are $20.

ADVERTISING RATES
¼ page — $25
½ page — $45

Our Internet presence is at
http://www.mvpcug.com
The Web Team
Dan Evans
Lisa Britt

PUBLICITY CHAIRMAN
Lou Barile

OFFICERS
AND
DIRECTORS

NEWSLETTER STAFF
Editor
Bob Schaffer

President
Jerry Finkelstein

MVPCUG members can now enjoy special
benefits and pricing from the publishers of Smart
Computing, CPU, PC Today, and CE Tips.
Subscribe to one magazine and have access
online to all four publications!
Smart Computing — For all skill levels, the
plain-English writing style will help you
improve your PC productivity and get the
most out of your computer. For more info,
visit www.smartcomputing.com.
Computer Power User — For the high-end
power user with a taste for cutting-edge
products and for those who enjoy the
challenge of mastering and implementing
new technologies. For more info, visit
www.computerpoweruser.com.
PC Today — Filled with practical Windows
advice that PC users can put to work
immediately. Step-by-step tutorials, the
latest operating system news, hardware and
software reviews, and PC gaming. For more
info, visit www.pctoday.com.
CE Tips — Covers the world of consumer
electronics from HDTV to your digital
camera. For more info: www.cetips.com.
For every five paid subscriptions MVPCUG
will receive a free subscription. Members family
and friends can order subscriptions . The unique
code numbers to use when calling (800)
733-3809 to order are:
Smart Computing: 12659
CPU: 935
PC Today: 570
CE Tips: 415

GET A FREE MVPCUG MEMBERSHIP
* It’s easy to do and you’ll save $20.00!
* Sign up two new members and you receive a one-year membership extension.
* You have 90 days in which to sign up

Vice President
Columnists

Lisa Britt

Jerry Finkelstein
Donna Gorrell
John Hunter
Kay Janowsky

The Explorer is printed by

Treasurer
Bill Gorrell

Secretary
Donna Gorrell

Stay connected . . . to the MVPCUG
Mohawk Valley PC User Group, Inc.
$25 for initial sign-up - $20 for renewal
Name___________________________
Address_________________________
City__________________________NY

Directors-at-Large

Zip________Phone________________

Dave Askew [‘05]

E-mail__________________________

The Gallery

4780 Commercial Drive - New Hartford

Marsha Thayer[’06]

315-768-7851

Bob Schaffer [‘07]

Please m ail with a check payable to M VPCUG to

MVPCUG
PO Box 586
Marcy NY 13403-0586
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More About Microsoft Access

[donated by Jerry Finkelstein]
Post-It notes . . . . . . . . . . . . . . . . Loralee Whitlock

Information on Microsoft Office Access 2003 can
be accessed at tinyurl.com/5p56t
On tinyurl.com/apg4p there is a demo that you can
view for setting up a database, and tinyurl.com/824ao
has information on creating a database.
Some hints and tips from the Microsoft site:
* Click Startup on the Tools menu to customize how
your application looks and acts when it is opened.
* Hold down the ALT key to drag a toolbar or menu
item without displaying the Customize dialog box.
* To quickly display the Properties dialog box, press
Alt+Enter.
* To close the Properties dialog box, press Alt+F4.
* Click Startup on the Tools menu to customize how
your application looks and acts when it is opened.
* You can use wildcards in the Search text box.
Type a question mark (?) to match any single
character, or type an asterisk (*) to match any
number of characters. For example, s?t finds "sat"
and "set"; s*d finds "sad" and "started."
* To open one of the
last several databases
you had open, click
the file name at the
bottom of the File
menu. Access opens
the database with the
same option settings it
had the last time you
used it.
* If the list of recently
used files isn't displayed at the bottom of the File menu, click Options
on the Tools menu, click the General tab, and then
select the Recently used file list check box.
* To sort records on partial field values, use the
Advanced Filter/Sort dialog box.
* To get help on a property in a property sheet, click
the property, and then press F1.
* In a form, remove a section and its controls by
selecting the section and then pressing DELETE.
* When working with forms, press F5 to quickly
switch from Design view to Form view.
* If you need more room to type a value in the
property sheet, press SHIFT+F2 to open the Zoom
box.

[donated by a member]
Beast Wars [game] . . . . . . . . . . . . . . . Bo Wozniak
The meeting adjourned at 8:30 PM. Donna Gorrell, secretary˜

Contact Bob Schaffer (853-5984) if
you’re interested in a one-time 2-hour
word processing workshop in June.

— Donna Gorrell, Secretary
The MVPCUG general meeting was held at the Whitesboro
High School. President Jerry Finkelstein called the meeting to
order at 6:02 PM. There were 48 persons in attendance.

BUSINESS MEETING
Treasurer Bill Gorrell reported that income was
$587.25, expenses were $332.48, and there is a
balance of $4,263.96 as of April 30, 2005.
Jerry announced that we will meet in June, but not
in July or August. The September meeting will most
likely be held at the Utica Maennerchor, but watch for
the September issue of Explorer for details. The
program for June will be Milt Broedel speaking about
Adware and Spyware.
The Photoshop SIG has been canceled due to lack
of leadership. It may resume in the Fall.
Jerry pointed out a recent feature on the website
— Links of Interest. This is only available by going to
the website. Each month webmaster Lisa Britt puts
up 2 links that coincide with the subject of that
month’s program.
Jerry reminded us that we may bring in items for
sale each month. They are to be displayed behind the
brick partition and all responsibility is on the seller.
A Question & Answer session followed.
PROGRAM
At 6:25 PM Linda Oltz began her presentation on
the Basics of Access. Linda had made handouts of
screen shots so that each member could follow along
with her presentation. She then preceded to teach us
the fundamentals of Access by setting up a database
with us. Linda asked for input from the audience as
she progressed in her demonstration. The presentation
concluded at 8:25 PM.
DOOR PRIZES
[furnished by Que’s Publishing Co]
Using Word 2003 . . . . . . . . . . . . . . . . . . Lisa Britt
[furnished with club funds]
5 DVDs . . . . . . . . . . . . . . . . . . . . . . Donna Gorrell
Photo Paper . . . . . . . . . . . . . . . . . Robert McMillan
Mini Mouse . . . . . . . . . . . . . . . . . . . . Bob Angelow
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Word Processing Tips
— by Bob Schaffer

WORD — Display table headings at the top
of every page (97/2000/2001/2002/2003)
When you create a lengthy table that spills over
onto the next page, Word doesn’t display the table’s
headings (i.e., the table’s first row) at the top of each
page that contains a portion of the table. This behavior
can make multi-page tables difficult to read. However,
you can easily configure Word to repeat a table’s
heading row wherever the table breaks across pages.
To do so:
* Place the insertion point anywhere within the
table’s first row, and then choose Table | Heading
Rows Repeat — (Table | Headings in Word 97) —
from the menu bar.
* Word automatically repeats the row contents
wherever the table breaks across pages.
* In addition, Word automatically adjusts the
placement of repeated heading rows so that when
you add or remove rows from the body of the
table, the repeated heading rows always appear at
the top of the page.
* And keep in mind that Word doesn’t display
repeated row headings onscreen when Normal,
Outline or Web Layout (Online Layout in Word
97/2001) view is active. This behavior is by design;
even though repeated row headings aren’t
displayed in these views, they’ll still be applied
when you print your document.
— How To Repeat Find
Suppose that you want to use Find to locate all
occurrences of a particular word. Do the following:
* Press Ctrl + F to open the Find and Replace dialog
box and type in your word.
* Then you click Find Next and locate one
occurrence of your word.
* You close the Find dialog box, but later on, you
want to find another occurrence of the same word.
All is not lost:
* One way to do this is to click the blue
double-down arrows on the vertical scrollbar.
* If you want to search backward rather than
forward, click the blue double-up arrows.

WORDPERFECT — Rearrange your
toolbar (8/9/10/11/12)
It’s easy to customize your toolbars and property
bars to look the way you want. You can edit the
toolbars by using a dialog box. But here’s a way to
drag your buttons within the toolbar or off the toolbar.
(This technique doesn’t work in Presentations.)
* To move a button to a new position on the toolbar,
press [Alt], then drag the button to a new location.
* You’ll see a vertical bar that moves with your
mouse pointer as you drag the button. This bar
indicates where the button will appear when you
release the mouse button.
* To remove a button, again press [Alt] and click
and drag the unwanted button away from the
toolbar area.
* When the mouse pointer becomes a trash can icon,
release the mouse button and the button is deleted
from the toolbar.
— Work smarter in tables with the Table
Tools Palette (8/9/10/11/12)
When working in a table in WordPerfect, the Table
property bar is displayed with many buttons to help
you edit the table. But you might find it faster to make
formatting and structural changes if you could have a
floating palette of frequently used tools available.
WordPerfect has such a feature and it’s called the
Table Tools Palette. To display the Palette:
* Right-click in the table and choose Table Tools
from the QuickMenu.
* The palette enables you to add borders, change
numeric format and add and delete columns and
rows with the click of a button.
* The palette floats above your document and you
can drag it to another part of the screen so you can
see your table.
* Click outside the table and the palette closes.
˜

Here’s a Neat Tip!
Would you like to receive a
Word and WordPerfect Tip
every week via email?
Send your email address to
rdschaffer@adelphia.net
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Did You Know . . .

— Donna Gorrell

. . that you should know about copyright issues on
the Web? Before you decide to post an image to the
Web, consider this: Many of the “free” Web-hosting
companies have special rules about images. Read the
fine print in the usage agreement, since many host
companies take away any right you have to your own
images. These Web hosts specify that any image you
post or upload to them becomes their property. Shop
around and read the fine print before you put your
beautifully created image on the Web!
. . that you could snap to grid in Word?
To display the Drawing toolbar, click Drawing
* On the Drawing toolbar, click Draw, and then
click Grid.
* In the Horizontal Spacing and Vertical Spacing
boxes, enter the spacing you want.
* To turn off the drawing grid, clear the Snap
objects to grid check box.
* To align objects with the vertical and horizontal
edges of other objects, select the Snap objects to
other objects check box.
. . that there are Word Processing keyboard shortcuts
to align text?
Ctrl+L = left align
Ctrl+E = center
Ctrl+R = right align
Ctrl+J = full justification
. . that you can remove passwords that you’ve told
your browser to remember?
* In Internet Explorer, click Tools | Internet
Options, then Select the Content tab. Click Auto
Complete. Click Clear Passwords, then OK. This
wipes out all your passwords.
* In Firefox, click Tools | Options. Click Privacy |
Saved Passwords. Click View Saved Passwords.
Select the Passwords Saved tab. Find the specific
address you no longer want to remember your
password and select it; click Remove, then click
Close | OK.
* In Netscape, click Tools | Password Manager.
Choose Manage Stored Passwords, then select the
website; choose Remove and close the window.

Page 5
. . .that if you have recently installed Firefox as your
default browser you can still retain IE and Netscape?
IE should never be removed as it is part of the Windows operating system and you will need it to do
updates for your system. I have all three browsers on
my computer and depending on what I am doing, use
any one of them. I made Firefox my default browser,
but simply clicking on the icon for one of the other
browsers opens them. To disable IE from being your
default browser, open IE, Click Tools | Internet Options. Select the Programs tab. Clear the box next to
“Internet Explorer should check...” Click Apply | OK.
If that does not work, there is a place to set program defaults. Click Start | Control Panel. Doubleclick Add or Remove Programs. On the left, click Set
Program Access and Defaults. You will find three
configurations. You can choose to accept all of the
Microsoft programs—IE; Outlook Express; Windows
Media Player; MS Virtual Machine, to read Java; and
your current instant messaging program. The second
choice allows you to enable substitute programs and
remove access to the MS programs.
Lastly, you
have a choice of customizing your selections. To
“remove access” doesn’t mean the MS programs are
removed from your hard drive. Rather, the icons are
removed. The programs are still there. Here, select
Custom and then, the down arrow on the right. Under
the default browser area, select Firefox; Click OK.
You still need IE to check for Windows Updates
which requires the use of an ActiveX control. Firefox
doesn’t accept links from such controls.
. . . that there is a small plug-in program that allows
you to surf the web and chat in real time? Two or
more people can shop online and compare their findings using JYBE. Download the plug-in at
www.jybe.com. Jybe adds a toolbar to IE or Firefox
with options to create or join a Jybe session. Traffic is
routed through Jybe’s servers at no cost to the user.
In addition to just surfing, Jybe offers the ability to
enter what they call “The Presentation Zone”. Registered users can share PowerPoint, Excel and Word
documents. The application could be used by students
researching a topic together; to give step by step instructions on how to use a web application; sharing
and editing photos; choosing gifts, movies, hotels,
flights and vacations; trading jokes and interesting
websites; sharing documents, presentations and
spreadsheets.
˜
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Sites to Visit on the ‘Net
— by John Hunter
June is the month for graduations, marriages, vacation
trips and the real beginnings of summer. If you have completed spring-cleaning your computer and want something
new to view, click on over to screensavers.com. This site
provides free screensavers for you to download. Want to
have a picture of Heidi Klum on your computer screen?
She’s free for the downloading. You can download pictures
of engaging puppies, private beaches, American Flags or
Sponge Bob Square Pants. All for free. According to the
web site, screensavers provides “the CleanScreen experience”. No viruses, no spyware, no spam, no worries, promises the site. You can get wallpaper if you want it for free
as well.
How is this possible, you ask? According to the web
site, the wallpaper and the screensavers function as loss
leaders or promotions in order for you to be introduced to
other software the company sells. If interested, you may
purchase AdZapper, pop-up ad killer, and a toolbar with
one-click access to the “web’s best search engine”.
The next site is very useful for sightseers and business
travelers. This site is addyourown.com. The site provides
useful maps and locations and reviews of restaurants, bars,
clubs, bookstores, bathrooms, coffee shops and attractions
in some major cities. Click on the URL and up comes a
map of midtown Manhattan. To the right is a list of other
related maps such as Gramercy Park-Murray Hill. These
sub-maps provide a listing of restaurants that include addresses, telephone numbers, average price of entrée and
type of fare such as Indian, Greek and so on as well as the
aforementioned reviews by ordinary people.
You can also get maps for Brooklyn, Boston, Chicago,
London, Los Angeles, Paris, San Francisco, Seattle, Vancouver, and Washington D.C. This site seems very, very
helpful. In Brooklyn, for example, there are 226 restaurants, 45 bars and clubs, 4 hotels, 7 bookstores, 15
restrooms, 23 coffee shops and 7 attractions. I clicked on
Brooklyn Heights and found 16 restaurants featuring Turkish, Italian, American, Vegetarian and Other.
Henry’s End, at Henry and Cranberry Streets, falls
under the “other” food category. Entrees begin at $25. But
the reviews say, “Best place in Brooklyn Heights”. They
have all kinds of steaks, chicken, (the Chilean sea bass is
unreal. It rivals Nobu). They also have wild game, duck,
boar, and turtle soup. The place is expensive and looks like
a hole in the wall, but its Zagat review does not lie. Another
review says, “Yes it’s expensive but worth every penny.
Reservations are only for parties of four or more . . .”.
Anyway, you get the idea. Enjoy.

My grandchildren love dinosaurs so this next site probably will not interest them, yet. But if you love myths, you’ll
love pantheon.org. Click on the URL and you get to the
homepage of Encyclopedia Mythica,” the award-winning
internet encyclopedia of mythology, folklore and religion”.
According to the site, “you will find everything from
A-gskw to Zveda Vechanyaya, with plenty in between”.
The material is arranged by geographic region: Africa,
Americas, Asia, Europe, Middle East and Oceana. Each
area has subdivisions to help your search.
The folklore section contains general folklore, Arthurian
legends and so on. In addition the site contains a bestiary,
legendary heroes, an image gallery, and genealogical tables
of various pantheons and prominent houses. If it exists in
literature, this site has it all. The Arthurian Legend section
contains the myths, a recommended reading list of various
Arthurian works, and links to Arthurian resources including
Welsh Arthurian materials. This site will appeal to general
readers as well as scholars. If summer days get boring, you
will know where to go.
Another site to visit on rainy summer days is bored.com.
This site is an encyclopedia of interesting site links. These
links include music, games, humor and romance among
others. When I clicked on the humor site I found a list of
the following links: bathroomlife.com (complete with a
bathroom habits survey), DancingBush.com (a chance to
see George W. Bush dance), office slang, and name-humor
to pick a few. When I clicked on DancingBush, I first had
to load an update of RealPlayer to play the clip. This took
longer than I expected which was irritating, especially since
the clip was not worth the time spent downloading the
update.
I clicked on music and found a list of sites that included
CyberParodies (pop song parodies), country song titles
(funny titles of real country songs), create bands, and talk
backwards (to find secret meanings in song lyrics). I clicked
on create bands and found myself in an interactive place.
This interactive site allows the visitor to create a performance band that performs music created in the style of the
band chosen. I chose Jethro Tull and immediately was
asked to choose a set background and lighting. Then I was
asked to choose the first musician, a rhythm guitar, horn,
bass and so on. The following steps required me to choose
four additional musicians and pick their instruments. When
I clicked the play button, the band began to play. The sound
I created was a boring loop of 10 notes, so I must have
done something wrong, but it was fun nonetheless.
One caveat, however. To avoid total frustration at this
site, you will need a broadband connection since all this
interaction requires a lot of bandwidth. Those with dial-up
modems should skip the create bands site.
Until next time . . .
˜
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Digital Photography with Photoshop Album in a Snap
by Jennifer Fulton and Scott M. Fulton III
Sam’s Publishing Co. 2004; 424 pgs. $24.99
Reviewed by Donna Gorrell
The authors begin this book with a primer on digital cameras, explaining the workings of the camera;
the variety of memory cards used, accessories for it,
and printers.
In the second chapter you learn the secrets of good
photography: how to frame the shot, the use of lighting, and how to be creative when taking a photo.
Chapter 3 discusses the ins and outs of capturing
nature, while Chapter 4 delves into the art of portrait
photography.
Part II of this book starts on page 155 and here
begins the nitty-gritty of Photoshop Album. Chapters
5 and 6 deal with importing images to Photoshop
Album, then viewing and sorting items. Part III
(Chapters 7 through 10) teach how to organize, find,
and fix images. Part IV details the creation of cards,
calendars, along with albums and slideshows.
Throughout the book, there are lessons which provide the “hand-holding” and precise instructions
geared to help the beginner learn the basics. More
than a manual, this book is a guide to getting things
done quickly and easily. It is full of hints and tips on
each page. The authors go beyond mere direction by
illustrating each and every example with photos and
screen shots, leaving no question as to the meaning of
the instructions. One marginal tip tells you that “the
world is your tripod if you only look—a park bench,
car roof, tree branch, stone railing, or countertop, all
make perfectly legitimate tripod substitutes”.
The authors are husband and wife. Jennifer has
more than 20 years experience as a computer consultant and trainer, and also has authored more than 100
computer books. Scott has written several books on
programming topics and was contributing editor to
Computer Shopper magazine. Jennifer’s brother, Michael Flynn is a professional photographer and serves
as a source of advice to the authors. The book reflects
the knowledge of the authors and provides a fun way
to learn.
The list price is $25, but it can be purchased at both
Amazon and Wal-Mart for under $16; a bargain for
the knowledge and expertise that it offers.
˜
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Byting Remarks
— Jerry Finkelstein
A good friend of mine recently bought a Hewlett
Packard three-in-one fax/copier/scanner. She loved it
until she took it out of the box. It wouldn’t set up.
The manual didn’t help. The local vendor couldn’t
help, didn’t know what was wrong, and advised calling HP. My friend called HP, spoke to a technician in
India. After a very long while of intense discussion,
the Indian technician said HP will send her a new start
up disc, maybe that will help. I don’t know where
they shipped the disc from but it took two full weeks
to get here. It worked. My friend loved it.
My friend loved it until she wanted to use one of
those little slots on the side of the machine to show off
her digital camera expertise and play around with
digital images. It didn’t work. No way was that machine going to receive the card. The manual didn’t
help. Calls to the local vendor didn’t help. We brought
the machine down to the store and their technician
examined the machine. The pins inside were severely
damaged. The acting store manager recommended
that we call HP.
We couldn’t just return the machine to the store
because the return policy no longer applied. Never
mind that the policy no longer applied because we
followed their advice in the first place, calling HP and
waiting two weeks for the disc. Never mind that we
received damaged goods which we couldn’t know
about since we couldn’t get the darn thing started until
we received that disc. It’s one of life’s lessons: return
the product at the first sign of something wrong with
it; maybe nothing is wrong with your purchase but you
don’t know that. Don’t take a chance, and certainly
don't take the manager’s advice. Just return it. But
happy endings are the rule. My friend once again
called HP. She talked to a technician in India (another
one). With no hesitancy at all, the good Indian sent my
friend a new machine. We used the old-new start up
disc. It worked. The card slot worked. Images appeared and my friend emailed one of them to her
daughter. My friend was thrilled. She loved it.
I hate naming names, so I won’t tell which local
vendor I'm referring to in this article. I know Donna
has a gripe about a competing local vendor. Maybe we
strong potential customers can set up a list of PC users’ complaints and present them to the local vendors.
Maybe with a list at hand some changes for community good can happen. Can’t hurt. Let’s have your
stories. We all have them. Share yours.
˜

Milt Broedel explains Spyware & Adware
Tuesday w June 7, 2005 w 6:00 PM w Whitesboro High School
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Enjoy your
Summer!

